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Welcome to your new EVO 8 audio interface. EVO 8 has been designed 

to remove the technical barriers creatives face when exploring the often 

intimidating world of audio and make recording simple for everyone.

EVO 8 includes four High-Performance EVO Preamps with innovative 

Smartgain technology, a JFET Instrument Input, pristine converters and 

a powerful headphone ampli�er. 

We hope you enjoy using EVO 8 and it helps you in your creative 

endeavours, whatever they may be!

Work smarter not harder.

WELCOME



3 4CONTENTS CONTENTS

09  Firmware Update Procedure

08  Speci�cations

10  Warranty Information

07  Software Features

Warranty Statement

What is meant by a Manufacturing Defect?05  Registration with ARC

02  Safety Instructions

03  Declaration of Conformities

04  Installation/Setup

01  Overview

Channels 1 - 4

Phantom Power

Volume Knob

Smartgain

06  Hardware Features

Output Volume

Mic Pre’s and Line Level Inputs

Smartgain

Stereo Linking

Instrument Input

Volume Control

Phantom Power

Menu

EVO Mixer

Advanced Features

Saving and Opening

Using Loop-Back on Mac

Using Loop-Back on EVO 8

Using Loop-Back on Windows

Muting

Warranty Limitations



5 6

OVERVIEW

04 Volume Knob

Control your speakers, headphones and channels all from one knob.

01 Smartgain
Just start playing or singing and Smartgain mode will automatically set 

the level of your microphones perfectly.

Give your microphones the power they need to perform to their best - all 

over bus power.

03 True Phantom Power Over USB

Set the levels of your headphones or speakers.

05 Output Volume Buttons

02 Channels 1 - 4
Control the level of inputs, link to Smartgain or hold down each button to 

mute. 

OVERVIEW

OVERVIEW OVERVIEW
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IMPORTANT SAFETY INFORMATION

Please read all of these instructions and save them for later reference 

before connecting the USB cable and powering up EVO 8.

EVO 8 itself does not operate with any high voltage mains supply 

inside the unit but appropriate safety measures should still be adhered 

to prevent electrical shock and �re hazards.

In the event of a unit failure, do not attempt to open the EVO 8 yourself. 

Please contact Audient support so that a suitable method of 

repair or replacement can be recommended.

support.audient.com

Consult a quali�ed technician if you suspect di�culties. 

Do not attempt to tamper with the unit whilst connected or 

disconnected - HAZARDOUS TO HEALTH

SAFETY SAFETY

To reduce risk of �re or electric shock, 

do not expose this apparatus to rain or moisture

No user serviceable parts inside

Please refer servicing to quali�ed service personnel

WARNING

01  Read these instructions

02  Keep these instructions

03  Heed all warnings

04  Follow all instructions

05  Do not use this equipment near water

06  Clean only with a dry cloth

07  Do not install near any heat sources such as radiators, heat

  registers, stoves, or other equipment (including ampli�ers) that  
  produce heat

08  Protect cables from being walked on or pinched particularly

  at convenience receptacles, and the point where they exit   
  from the equipment

09  Only use attachments/accessories speci�ed by the manufacturer

 1 0  Switch o� your computer and unplug this equipment during   
  lightning storms or when unused for long periods of time

11  Refer all servicing to quali�ed service personnel. Servicing is 

  required when the equipment has been damaged in any way, liquid  
  has been spilled or objects have fallen into the equipment, the  
  equipment has been exposed to rain or moisture, does not operate  
  normally or has been dropped

http://support.audient.com
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DECLARATION OF CONFORMITIES

Re-orient or relocate the receiving 
antenna01 Increase the separation between the 

equipment and receiver02 

03 Connect the equipment into an 
outlet on a di�erent circuit from that 
to which the receiver is connected

04 Consult the dealer or an experienced 
radio/TV technician for help

This apparatus has been tested and found to comply with the limits of 

a class-A digital device, pursuant to Part 15B of the FCC Rules. These 

limits are designed to provide reasonable protection against harmful 

interference in a residential installation. 

This equipment generates, uses and can radiate radio frequency 

energy and if not installed and used in accordance with the 

instructions, may cause harmful interference to radio communications. 

If this equipment does cause harmful interference to radio or television 

reception, which can be determined by turning the equipment o� and 

on, the user is encouraged to try to correct the interference by one or 

more of the following measures:

DECLARATION DECLARATION

Under an environment with electrostatic discharge, the device may cease to output 

sound (EUT could not operate properly). This requires the user reset the device by 

unplugging & re-connecting to host computer.

EVO by Audient has conformed where applicable, to the European Union’s Directive 

2002/95/EC on Restrictions of Hazardous Substances (RoHS) as well as the following 

sections of California law which refer to RoHS, namely sections 25214.10, 25214.10.2, 

and 58012, Health and Safety Code; Section 42475.2, Public Resources

We, EVO by Audient, declare that the product, the EVO 8, to which this declaration 

relates, is in material conformity with the appropriate CE standards and directives for 

an audio product designed for consumer use.

01 This device may not cause harmful interference

02 This device must accept any interference received, 
 including interference that may cause undesired 
 operation

We, EVO by Audient, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 01256 381944, 

declare under our sole responsibility that the product EVO 8 complies with Part 15 of 

FCC Rules.
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INSTALLATION / SETUP

On macOS, EVO 8 will work straight away without needing to install any 

drivers. However, we do recommend installing the EVO 

application which gives you control over routing, Audio Loop-back and 

lets you update your �rmware.

Head to the EVO 8 downloads page to download the latest version of 

the application. Once downloaded, simply open the .dmg �le and then 

drag and drop the EVO application into your applications folder. 

INSTALLATION / SETUP MAC OS

Carefully unpack your EVO 8 and connect it to a USB port on your Mac. 

If your computer doesn’t have rectangular USB-A ports then you may 

need to use an adaptor, dongle or third party cable.

You can then set EVO 8 as your main outputs by going to System 

Preferences > Sound and then selecting the EVO 8 as your device for 

Input and Output

System Preferences > Sound Select EVO 8 as input / output

https://evo.audio/products/audio-interfaces/evo8/downloads/
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INSTALLATION / SETUP

EVO 8 will require drivers on Windows so that the computer and EVO 8 

will work together. You can download these from the downloads page 

on the EVO 8 page.

Once downloaded, run the .exe �le to start the installation process. 

Follow the instructions on screen to complete the installer. This process 
may take a little while so please be patient.

INSTALLATION / SETUP WINDOWS

Once complete, click �nish. Now carefully unpack your EVO 8 and 

connect it to the computer using the included USB cable. 

To set the EVO 8 as your default sound device, go to Control Panel > 

Hardware and Sound > Sound. Now select the Playback tab. 

In the list of devices, �nd EVO 8 Main Output 1+2, click on it and select 

Set Default Device.

For more advanced settings such as changing your sample rate or 

bu�er size, please read the Software features section, found later in 

this manual.

Control Panel > Hardware and Sound > Sound

https://evo.audio/products/audio-interfaces/evo8/downloads/


15 16

REGISTRATION WITH AUDIENT ARC

Compatible with all major audio software, EVO 8 comes bundled with a 

collection of professional software and services, giving you everything 

you need to start recording.

Go to arc.audient.com and select register your product, then enter your 

details to create an account. 

You will then receive a veri�cation email to your inbox - double check 

your spam and junk folders if you cannot see this. Once you’ve veri�ed 

your account, register your EVO 8 by entering the serial number and the 

unique 4 digit PIN found on the underside of EVO 8. 

Once you have registered the product, you can now select from a wide 

array of o�ers and promotions, giving you easy access to powerful 

creative tools straight away.

REGISTRATION REGISTRATION
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HARDWARE FEATURES

HARDWARE HARDWARE

EVO 8 includes four high-quality Mic Preamps, available through the four 

Combi connections found on the rear of EVO 8.

To connect a microphone, use an XLR cable which has three pins. 

Mic Pre’s and Line Level Inputs
To connect a line-level device, use a ¼” TRS jack, which will connect to the 

centre of the Combi connector. The Line input automatically reduces your 

signal level slightly to minimise the chance of overloading the input and 

causing distortion. 

EVO 8 can lower the signal level by 4 decibels and boost it by up to 48 

decibels allowing you to get the perfect recording level, this is known as the 

Gain.

You can manually control this by pressing one of the Input buttons and then 

turning the Volume Knob. The meters will light up to show you the

approximate gain level.

However, EVO 8’s Smartgain feature can help you take the guesswork out of 

setting your Gain levels and give you perfect levels quickly and easily. 

XLR Cable
Connection

TRS Jack
Connection

Volume Knob
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The EVO 8 Smartgain feature can help you take the guesswork out of 

setting your gain levels and give you perfect levels quickly and easily. 

For a guide on setting up Smartgain, see the page opposite.

Once Smartgain has set the optimal gain level, you can make small

adjustments by pressing one of the input buttons and then turning the 

volume controls manually.

Smartgain

Activate Play Record

EVO 8’s most exciting and game changing feature is 

‘Smartgain’. Start playing or singing and Smartgain mode 

will automatically set the level of your microphones.

Setup

The Smartgain LED will start �ashing 
red and the volume wheel LED’s will 
illuminate indicating that Smartgain 
Mode is now listening 

Smartgain Mode will dial in the 
correct levels and when complete 
the Smartgain button will �ash 
green twice to indicate it has been 
successful

Start playing or performing into the 
microphone

5

6

7

You are now ready to start 
recording

8

Press the Smartgain button to begin

The Smartgain LED will illuminate 
green and the input channel LEDs (1, 2, 
3 & 4) will begin to �ash (indicating a 
channel must be selected)

Press one or more of the input channel 
buttons to select the channels to be 
adjusted

Press the Smartgain button again to 
begin the process

1

2

3

4

HARDWARE FEATURES

Smartgain

HARDWARE HARDWARE
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Some microphones will require phantom power in order to function. This is 

+48 volts of power sent via the XLR cable and used to correctly power up 

the microphone and allow it to work. 

Microphones that require phantom power are typically condenser 

microphones. In rare cases, microphones that don’t require phantom power 

can be damaged by providing phantom power to them so we’d recommend 

checking the microphone’s documentation to see if you need to provide 

phantom power or not. 

To enable phantom power on EVO 8, simply press the channel button you 

wish to use phantom power on and then press the 48V button. This will then 

remain illuminated red to remind you that phantom power is active on the 

selected channel. 

If EVO 8 is connected to a USB-A port then you’ll only be able to use 2 

channels of phantom power at one time. If the EVO 8 is connected to a 

USB-C port that can provide 1.5A of current then you can use all 4 

channels at the same time.

Phantom Power

Channels 1+2 and 3+4 can be stereo linked, which allows you to match the 

gain for both channels to make sure your left and right channels are at the 

same level. 

This would be used when recording an instrument using two microphones, 

such as a piano or guitar, or if inputting a stereo line signal like a synth or DJ 

decks. 

To do this, press down the 1 and 2 buttons or the 3 and 4 buttons at the same 

time. The Channels in the software mixer will then automatically change to 

a Stereo Channel to re�ect this.

Whilst two channels are linked, selecting one of the channels will 

automatically select the linked channel as well. 

Stereo Linking 1 2 3 4 48V1 2 3 4
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EVO 8 includes a dedicated Instrument input to directly connect 

instruments such as guitars and basses. The Instrument input is  sometimes 

also known as a DI (Direct Injection) and provides a high  input impedance, 

which enables you to get the best tone from your instruments.

The DI port is found on the front of EVO 8 and accepts an unbalanced TS 

jack, just like the ones you’d plug into a guitar amp.

Instrument Input

When a guitar Jack is plugged into the Instrument Input, the signal is sent 

to Input Channel 1 and overrides what is currently connected to the Mic/

Line input for Channel 1.

You would then simply set your gain as you would with the Mic/Line 

inputs, either using Smartgain or the main knob.

HARDWARE HARDWARE

Instrument
Input

EVO 8 allows you to quickly Mute both the Outputs and the four inputs. 

Simply press and hold any of the channel buttons or either of the Output 

volume buttons to quickly mute them.

The button will then �ash to indicate it is muted. To unmute it, simply press 

and hold it again.

This is useful to quickly mute a microphone during a podcast or to mute the 

sound to your speakers to quickly take a phone call for example.

EVO 8 provides  you with two separate controls for the two sets of outputs. 

Pressing the Volume Control 1 button will adjust the volume of the 1+2 speaker 

outputs or the �rst headphone output and pressing the Volume Control 2 will 

allow you to separately adjust the volume for Speaker Outputs 3+4 or the 

second headphone output.

To adjust the output volume, simply tap the output you wish to adjust and 

turn the control knob. The Meter ring will illuminate to show the current 

volume level.

Volume Control

Muting TS 1/4” 
Jack
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SOFTWARE FEATURES

EVO 8 monitoring includes a powerful software mixer and the Audio 

Loop-back feature giving you complete control over your Monitoring and 

Loop-back audio. On MacOS, the EVO Mixer application will open in the 

Menu Bar in the top right hand corner of the screen. 

This menu gives you the following options: 

Quit

This fully quits the application and stops it from running in the background.  

About EVO

The About EVO option allows you to check your current software and 

�rmware versions and provides further information about the software.

Visit EVO Knowledge Base

This option will open a browser window allowing you to access technical 

support and FAQ’s for EVO 8

Register Product

This will open a browser window for the Audient ARC website where you can 

register your interface to access free promotions and software. More 

information about ARC can be found on pages 15-16

Check For Updates

This option will check if any updates are available for your EVO 8 to add new 

features or support for future operating systems. If any updates are available 

then you’ll be prompted to install them.

Set Loop-back Source

This allows you to select which channels are sent to your Loop-back inputs. 

More information about Loop-back can be found on pages 32-34.

Set ASIO bu�er size

This allows you to adjust the bu�er size used by the ASIO driver which in turn 

controls how hard your computer has to work to process the audio. 

Set Sample rate

This allows you to select between 44.1kHz, 48kHz, 88.2kHz and 96kHz as your 

sample rate. Ensure that this matches what you are using in your recording 

software if possible.

Show Mixer

This menu item opens the software mixer Window. More information about 

the mixer can be found on pages 27-28.

On Windows It will open in the system tray found in the bottom right hand 

corner of the screen.
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EVO Mixer

The EVO software mixer software allows you to completely control your 

monitoring for recording, mixing or content creation. 

Each fader has the following functions:

Pan Control - This allows you to monitor the audio on either the left speaker, the 

right speaker or anywhere in between.

Stereo/Mono - Adjacent tracks can be stereo linked for when you are recording 

a stereo source, such as a synth or when using stereo mic techniques.

Solo (S) - Solo will mute every other input apart from the channels that have 

the solo button selected.

Mute (M) - This will mute the track so it is no longer being monitored.

Meter - This shows the current input level of a particular channel. If the signal 

level is too high, a red “Clip” indicator will show at the top of the meter. In this 

instance, you may need to adjust the Gain of your inputs or the volumes in your 

recording software.

Fader - The fader determines how much signal is sent to the outputs. The faders 

have an additional 6dB of monitoring gain available allowing you to boost a 

quiet signal, this is done by pulling up the fader to the +6dB point.

In the mixer there are multiple channels from di�erent sources. These di�erent 

channels are explained below:

Mic 1, 2, 3 & 4 - These are the four microphone inputs of the EVO 8. Pulling up 

the faders for these channels allows you to listen to the 4 inputs through your 

speakers or headphones with very low latency

Mac 1+2, 3+4 or Windows 1+2, 3+4 - This is your playback DAW from your 

computer, such as playing back recordings or instruments from your DAW, or 

just playback from media players or web browsers. Pulling up the fader for these 

channels allows you to play this back through your EVO 8. 

On the far right side of Outputs 1+2 and Outputs 3+4 is the master section. From 

here you can adjust the output levels of the 1+2 Outputs and the 3+4 outputs 

independently. You can also hide either the Mic or DAW channels if you’re not 

using them by clicking the  corresponding “eye” buttons at the bottom of the 

master sections.
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Advanced Features

Mic Pre Controls - The Mic pre’s on EVO 8 can be remotely controlled from the 

EVO Mixer software. To enable this go to the “View” menu and select “Show Mic 

Pre Controls”.

Once this is enabled, on the bottom of each channel, you’ll see a gain control 

and a +48V button.

The +48V button will enable phantom power on this channel and the Gain 

control will adjust the gain level on the EVO 8 itself. Allowing you to make quick 

changes to your setup without having to look away from the computer during 

a busy session.

Artist Mix - EVO 8 allows you to have a di�erent mix being sent to Outputs 3+4 

(Headphone 2), using a feature called Artist Mix.

This can be enabled by going to the Setup Menu and selecting “Enable Artist 

Mix”.

You can then adjust the audio being sent to Outputs 3+4 by clicking on the 

Output 3+4 in the master section of the mixer. This will then open the second 

mixer indicated by a yellow band across the top of the screen.

Examples of when you may wish to use this would include, having an engineer 

using the main speakers (Outputs 1 + 2) and having an artist using headphones 

(Outputs 3+4) with both listening to separate mixes. The engineer would use the 

Outputs 1+2 to listen to the overall mix for example while the output 3+4 mix can 

be used to send a click track or direct monitoring from the microphones just to 

the artist.
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If you have a con�guration you want to use again in the future then you can 

save it as a preset. EVO 8 will save all your settings to allow for speedy recall.

To Save a con�guration, go to File > Save. 

You can then give the con�guration a name and click Save. If you’d like to send 

your settings to another computer or EVO 8 user, you can click Export Mixer 

Setting to File and you can save this to your documents.

EVO CONFIGURATIONS

SAVING AND OPENING

To open a previously saved con�guration go to File > Open and select the 

con�guration from the list. 

You can also delete a previously saved con�guration by clicking the red X next 

to it. 

If you’d like to open an EVO 8 con�guration from your documents, simply click 

“Load From File” and then use the �le explorer to �nd the setting you wish to 

load. 

EVO 8 includes a loop-back channel allowing you to take audio from 

applications on your computer and feed it to another application, great for 

recording video interviews or for setting up gaming streams.

The loop-back audio will be on input channels 5+6 of the EVO 8 and you can 

choose from what source the loopback audio is taken from in the EVO menu.

USING LOOP-BACK ON EVO 8
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The �rst step is to decide if you’d prefer to use the dedicated loop-back 

channel or if you’d prefer to use the Master or Artist mixes as your source. The 

Master or Artist mixes are better if you wish to combine your microphones and 

Loopback audio into a single feed.

If you choose to use the dedicated loop-back channels, the �rst step is setting 

up your computer to output sound to the Loop-back outputs of EVO 8. On 

some software, you can change this in the software itself in the settings. For 

details on how this is done, we’d recommend contacting the developer of your 

software or reading through its manual.

Otherwise, for software that doesn’t allow you to set the output channel, such 

as web browsers or video call services, you may need to adjust your output 

setting in the Mac Audio MIDI setup.

To open the Audio MIDI setup go to �nder and click:

Applications > Utilities > audiomidisetup.app

USING LOOP-BACK ON MACMAC/WINDOWS 1+2

MAC/WINDOWS 3+4

LOOP-BACK 1+2

MASTER MIX

ARTIST MIX

This option will take audio from any playback to the Output 1+2 channels on 

EVO 8. This will typically be your main playback channel from most software. 

This option will take audio from any playback to the Output 3+4 channels on 

EVO 8. 

This allows you to take audio from the dedicated EVO 8 loop-back channels 

which are outputs 5+6.

This option allows you to take the source from the master mix you have created 

in the EVO mixer. This is great for combining audio from your microphones and 

loopback channels into a single feed.

If you have the Artist Mix enabled (details on pages 30), you can also use this 

as a loop back source. Again, you can combine Mic and Loop back channels, 

but means that your loop back mix can be di�erent to what you are listening 

to via your Master mix.
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Then select EVO 8 from the list of devices and select Con�gure Speakers:

Then simply set your left and right output to Loop-back 1 (L) and Loop-back 2 

(R). Now any audio played back from your Mac will be sent through the 

Loop-back Mixer, ready to be recorded or streamed. 

Otherwise, if you are using the Master Mix or Artist mix, open the EVO Mixer and 

use the faders to create your Master or Artist Mix.

Now that the Loop-back output is set up, you would then simply need to open 

the software you will be using to capture or stream the audio and set your audio 

input to the Loop-back inputs. 

Depending on your software, this may appear as Loop-back 1+2 or just as Input 

5+6.

As with MacOS you can use either the Dedicated loop-back channel or the 

Master/Artist Mix. 

If using the dedicated loop back channels, the �rst step of is setting up your 

computer to output sound to the Loop-back outputs of EVO 8. On some 

software, you can change this in the software itself in the settings. For details on 

how this is done, we’d recommend contacting the developer of your software or 

reading through it’s manual.

Otherwise, for software that doesn’t allow you to set the output channel, such 

as web browsers or video call services, you may need to adjust your output 

setting in the Windows Sound Settings. 

This can be adjusted by going to Control Panel > Hardware and Sound > Sound. 

Now select the Playback tab. 

In the list of output devices, �nd Loop-back 1+2, select it and then click Set 

Default Device, Applications will then default to sending audio to the 

Loop-back output. 

Otherwise, if you are using the Master Mix or Artist mix, open the EVO Mixer and 

use the faders to create your Master or Artist Mix.

As with Mac, you’d simply need to open up your recording or streaming software 

and select Loop-back 1+2 or Input 5+6 as your Input.

USING LOOP-BACK ON WINDOWS
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SPECIFICATIONS

Phantom Power:

INPUT IMPEDANCE:

48V +/-4V @ 10mA/Channel (only 
2 channel available on USB-A host 
computers)

1MegΩ Unbalanced

CMRR:

THD+N @ 0dBu (1kHz):

>85dB @ 1kHz

<0.3%

Maximum Input Level: +16dBu

Input Impedance (Mic): >3kΩ Balanced

Input Impedance (Line): >10kΩ Balanced

Frequency Response: +/-0.5dB 10Hz to 40kHz

Crosstalk: <-105dBu @ 1kHz & 10kHz

THD+N @ 0dBu (1kHz): <0.0015%

SNR: 100dB

Mic EIN:

SPECIFICATIONS

<-128dBu

SPECIFICATIONS

XLR:

1/4” Jack:

Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)

TIP (Hot), RING (Cold) & SLEEVE (Shield)

MICROPHONE PREAMPLIFIER:

Mic Gain Range: 58 dB

Line Gain Range: 58dB with -10dB Pad

D.I:

D.I Gain Range:

MAXIMUM INPUT LEVEL:

SNR:

FREQUENCY RESPONSE:

58dB

+10dBu

100dB

1/4” JACK: TIP (Hot) & SLEEVE (Shield)

+/-0.5dB 10Hz to 20kHz

DAC OUTPUTS:

Maximum Output Level: +11dBu

Digital Reference Level: 0dBFS = +11dBu

Output Impedance: <100Ω Balanced

Frequency Response: +/-0.5dB 10Hz to Fs/2

Crosstalk: <-110dBu @ 1kHz

THD+N @ -1dBFS (1kHz): <0.0015%

Dynamic Range: 113dB A-weighted

1/4” Jack: TIP (Hot), RING (Cold) & SLEEVE (Shield)

HEADPHONE OUTPUTS:

Output Impedance: <50Ω

Frequency Response: +/-0.5dB 10Hz to Fs/2

Crosstalk: -110dBu @ 1kHz

THD+N @ -1dBFS (1kHz): <0.0015%

Dynamic Range: 113dB A-weighted

Max Level Into 30ohms: +0.5dBu, 0.0025% THD+N, 
1.16Vpk Power: 45mW

Max Level Into 60ohms: +4.22dBu, 0.0015% THD+N, 
1.78Vpk Power: 52mW

Max Level Into 600ohms: +10.1dBu, 0.0018% THD+N, 
3.52Vpk Power: 20mW

1/4” Jack: TIP (Left), RING (Right) & SLEEVE (Shield)
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Note for latency �gures: 
 
Performance may vary as stability at these low bu�er sizes is dependant on 
many factors including CPU load, operating system and performance of other 
drivers. 

SPECIFICATIONS

44.1 kHz

48.0 kHz

88.2 kHz

96.0 kHz

0.594ms

0.552ms

0.302ms

0.281ms

DSP Mixer Roundtrip (in to out) Latency:

USB Type-CConnector:

1m USB 2.0 Type-C to USB Type-C

USB 2.0 HIGH SPEED

No. Of Input Channels 4 Analogue

No. Of Output Channels 4 Digital

Included Cables:

DAW Roundtrip Software Monitoring Latency @ 32 Sample Bu�er (in 
to out):

44.1 kHz 5ms

96.0 kHz 4.1ms

DAW Playback Latency @ 32 Sample Bu�er for Software Instrument 
Playback:

44.1 kHz ~2.5ms

96.0 kHz ~2ms

WEIGHTS & DIMS:

DIMENSIONS: Unit:

Packaged:

WEIGHT: Unit:

Packaged:

190mm (w) x 70mm (h) x 70mm (d)

230mm (w) x 105mm (h) x 95mm (d)

475g

815g
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FIRMWARE UPDATE PROCEDURE

To update your �rmware, go to the EVO Application menu and select Check 

for Updates.  

FIRMWARE UPDATE FIRMWARE UPDATE

Provided you have an internet connection, the EVO app will now check with 

our update service to see if there are any new �rmware updates for your 

EVO 8. 

If a �rmware update is available, you’ll be prompted to install it directly 

from our update service. This should take no longer than a minute or so. We 

recommended that all speakers are switched o� before updating.

During the update procedure, the unit will restart multiple times.
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WARRANTY INFORMATION

Your EVO 8 comes with a manufacturer’s warranty for one year (12 months) from 

the date of despatch to the end user. 

The warranty covers faults due to defective materials used in manufacture and 

faulty workmanship only.

During the warranty period Audient will repair at its discretion or replace the 

faulty unit provided it is returned carriage paid to an authorised Audient service 

centre. We will not provide warranty repair if in our opinion the fault has resulted 

from unauthorised modi�cation, misuse, negligence or accident. 

We accept liability to repair or replace your EVO 8 as described above. We do 

not accept any additional liability. This warranty does not a�ect any legal rights 

you may have against the person who supplied this product - it is additional to 

those rights. 

Warranty Statement
Whilst this warranty is provided by Audient, the warranty obligations are ful�lled 

by the exclusive territory Distributor responsible for the country in which you 

purchased the product. 

The Dealer will advise you of the appropriate procedure for resolving the 

warranty issue.

In every case it will be necessary to provide a copy of the original invoice or 

Dealer purchase receipt to the Distributor.

In the event that you are unable to provide proof of purchase directly then you 

should contact the Dealer from whom you purchased the product and attempt 

to obtain proof of purchase from them. The Dealer | Distributor will then advise 

the procedure to follow.

This limited warranty is o�ered solely to products purchased from an Authorised 

Audient Dealer (de�ned as a Dealer which has purchased the product directly 

from Audient in the UK, or one of our Authorised Distributors outside the UK).

Please note that if you purchased the product from outside of your country of 

residence you must return the unit to the original point of purchase for repair.

The Audient warranty term is additional to any statutory rights in the country of 

purchase or as o�ered by the dealer at the time of purchase.

 

We de�ne this as a defect in the performance or speci�cation of the product 

as described and published by Audient.

A Manufacturing Defect does not include damage caused by post-purchase 

shipping, storage or careless handling, nor damage caused by misuse.

WARRANTY

What is meant by a Manufacturing Defect?
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This warranty does not cover damage resulting from accident or misuse.

The warranty is void unless repairs are carried out by an authorised service centre.

The warranty is void if the unit has been modi�ed other than at the manufacturer’s 

instruction. 

The warranty does not cover components which have a limited life, and which are 

expected to be periodically replaced for optimal performance. 

We do not warrant that the unit shall operate in any other way than as described 

in this manual.

For further details please contact: support@audient.com

Warranty Limitations

WARRANTY INFORMATION

Tel: 0044 1256 381944  support@audient.com  evo.audio

http://evo.audio

